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Summary 
 

This report has been written as part of the internship at the KNMI from November 2013 

till January 2014. During the internship, two maps of the Seismology department were 

revised from scratch to the current state of art. The report explains all the results of the 

internship in a clear way to make revising of the maps in the future easier. Besides this, 

the report contains Quick Reference Guides, which can help to convert the templates into 

a map in a short time. 
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Introduction 
 

 

Supervisor: Gert-Jan van den Hazel / Raymond Sluiter 

Subject: visualizing the seismological data state of art with ArcGIS  

 

In the last twenty years, the GIS data for the seismology department of KNMI has grown 

enormously. All data and shape files have been stored in the database but because of its 

large size, it has become more and more inefficient and unclear. Because the ArcGIS 

templates were gradually changed over the time, the taken analyses are not clear and 

logical. A lot of tables and formulas are given twice or in a lot of different ways. 

Meanwhile, the program ArcGIS itself has been changed over the years, which caused 

changes of analyses and buttons.  

 

Because of a redistribution of tasks inside the department, this is a good time to revise 

the GIS database and renew the maps from scratch, as efficient as possible. This 

renewing has now resulted in clear maps with as less shape files and layers as possible. 

 

In this report, first the internship content will be explained, 

followed by the clarification of the changed maps as part of the two internship tasks. In 

this section, it is written down what analyses have been done, how the resulting 

templates can be kept up to date in the future and how these templates can be 

converted into a map or poster. 

 

The two tasks were as follows: 

1. Renewing the overview map ArcGIS templates and use them to create a new poster: 

‘seismicity map of the Netherlands’ (called: the overview map)  

2. Setting up a new analysis map used to show the last analysed quake (called: the 

analysis map) 

Thereafter, it is explained how the data is structured now in the geo database and how 

this data needs to be used.  

 

In the appendices all figures of the used complicated analyses and the quick reference 

guide are given. The quick reference guide can be used to convert the templates into a 

map or a poster in a short period of time.  

Looking into the future, the program ArcGIS will change several times and the KNMI 

maps will be used for other goals. When revising is needed again, this report could be 

helpful to do this in a short time.  

 

The overall output of the internship is: 

- Renewed maps (built up from scratch), coupled with a clear Geodatabase 

- A presentation at the VU and KNMI 

- An article in the GIS Magazine 

- This report which can be read as a manual 
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Part one: Revise the overview map  
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Purpose of the map 
 

 

The overview map is a seismicity map of the Netherlands that visualises the spatial 

distribution of all the earthquakes in history throughout the country. To give extra 

information about these earthquakes and partly explain why they occur, several other 

attributes are shown, e.g. the fault-lines to explain the tectonic earthquakes and the 

location of gas fields to clarify their relationship with the induced quakes. 

This map is mainly used to be converted into a large poster, which can be found on the 

wall in the analysis room at the seismology department at KNMI. Visitors, new employees 

and interested people can watch this poster to see the overview of quakes in the 

Netherlands and surroundings. A person who sees the map should immediately 

understand what all the colours, shapes and sizes mean, which is difficult to accomplish, 

since a lot of attributes must be shown. 

Besides this, the map can be used as a map on the internet so it can be viewed by many 

other people.  

 

The map has a quite high resolution to make the poster visually at its optimum, and 

consists of the following components, layered most efficiently upwards from below: (see 

appendix 1) 

 

-Elevation map 

-Borders 

-Faults 

-Gas fields 

-Events 

-Stations 

 

These are extensively described in the following parts. 

 

 Design with ArcGIS 
 

To make the map as clear as it should be, the database had to be revised too. It was 

decided to design a complete new map from scratch by setting up a map template, which 

should result in an efficient structural map. The goal for this part of the internship: 

making a map which is at least as good as the old map, but trying to make it even 

better. 

The map was set up layer by layer, each time keeping in mind that it should be efficient 

to store in the database and easy to possibly repeat the analyses in the future. Some 

layers were set up almost in the same way as it was done in the old map. Other layers 

changed in colour or size and others were deleted or replaced by more recent datasets. 

 

It was decided to draw the map using the projection of the coordinate system RD new, 

because this system gives the country the shape as it should have, in the eyes of every 

Dutch person. Actually, this map shows the correct distance between places (so-called 

equidistant), which results in a less realistic shape. However, each citizen of the 

Netherlands is used to this shape and when the map would be converted into another 

coordinate system (e.g. WGS) it will become less clear. Showing Europe in its entirety in 

the RD, will give it a ‘unreal’ shape, but as long as not the whole of Europe is shown on 

the map, the borders will retain their ‘real’ shape (Kadaster, 2013).  

In this chapter, the analyses and used tools in ArcGIS are given layer by layer. An 

explanation on each layer is given with the assumptions and considerations which have 
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been taken. To make modifying the maps in future easier, the source of each layer is 

mentioned, and where the data is stored in the new geodatabase. 

In the figures in appendices 1 and 2, each layer is given to clarify how the template is 

being designed.  The Template in which the map is designed can be found in: Map 

geodatabase: 1.Overzichtskaart.gdb 
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Layer: Elevation 
 

 

 

 

 

Database:  1.Geodatabase_KNMI_Kaart\Elevation 

Source:  -Aster (NASA)  

  -RWS AHN (Actueel Hoogtebestand Nederland) (AHN, 2013) 

 

Type:   Raster Grid, continuous, signed integer. 

Resolution: 15x15 m cell size and 100x100m cell size 

Units:  meters 

Definition: Background base map of the map, giving the elevation in meters. 

Purpose: Clarify the possible relationship between elevation and tectonic 

earthquakes and between elevation and faults. 

 Can give information on presence of induced quakes in lower areas. 

 Exaggerate the elevation in the Netherlands, by using a manual                                 

‘logarithmic’ colour scale (see: colours) 

 
Considerations / Detailed information: 

This dataset has been set up using different sources. The ASTER file from NASA 

has been downloaded from the internet. (Aster, 2009). Because of the high 

resolution of 0.5x0.5 meter, which is too high than needed for this purpose, some 

analyses and tools were used to convert the data into one raster map. This can be 

found below.  

However, this data was not reliable at locations where the elevation was lower 

than sea level (‘polders’). It was decided to use the AHN of Rijkswaterstaat where 

the Aster dataset was not reliable. The following tools were used: 

 
 Aster:  

 Converted into a mosaic file (see Appendix 5) 

 Tab ‘Symbology’: Stretched symbology 
 AHN: 

 Converted into a mosaic file (see Appendix 5 for an example).  

Tab ‘Symbology’: Classified symbology in which all values >150 meters are 

excluded. In  this way, only the lower parts of the Netherlands are given. The 

parts above sea  level are visualised by Aster. Same raster grouping values as 

‘Aster’ imported.   

 

Colours: The colours vary in a scale between Green, Yellow, Brown, Grey and White. 

Important for this layer was the visualisation of the elevation in both the 

high and low areas of The Netherlands. This was done by making the colour 

scale logarithmical. In other words: Changing from the colours green to 

yellow on the map, is a difference between -4 meters and 10 meters while 

changing from the colours brown to grey means a difference between 150 

and 200 meters. In this way, the small elevations in ‘de Utrechtse 

Heuvelrug’ are as notable as those in ‘de Ardennen’. At least it attracts 

more attention, because this is not the usual way of visualising the 

elevation. (See Appendix 5) 

 



Visualising KNMI seismologic data using ArcGIS 10.0  | January 18th 2014 

 

    13 

Layer: Borders 
 

 
 

Database:  1.Geodatabase_KNMI_Kaart\Borders 

  

Definition:  All layers which are not important for the real purpose of the map, but 

which do have to be shown to make the map clear.  

Purpose:  Create clearance about the map, e.g. to see where the border of the 

country is, and to have an idea of where the rivers are situated. 

 
 Country border 

Source: Bens01\datasets\KNMI\Europe\Countries 

Type:  Vector 

Info:  Only visible at the border between two countries. Shape file is made 

hollow, so only borders are visible. Data frame clipped by rectangle (Arctoolbox > Spatial 

Analyst Tools > Extraction > Extract by rectangle) 

 
 River (NL and EU) 

Source: Bens01\datasets\KNMI\Netherlands 

Type:  Vector 

Info:  Same colour as sea. Outline width: 0,5 

 
 RD Grid 

Source: Gisdata\Seismo 

Type:  Vector 

Info:  Grid of X and Y tiles 

 
 Seas 

Source: Bens01\datasets\KNMI\Netherlands 

Type:  Vector 

 
 Lakes 

Source:  Bens01\datasets\V&W\WIS 

Type:  Vector feature class 

 
Considerations/Detailed information: 

On top of this layer: sea, to make borders between country and sea invisible for a 

better look of the map. The polylines are made visible on borders between country 

and country. 
 

Colours:  Seas/Rivers: RGB: 158.187.215.   

RD_grid: Light grey 
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Layer: Events 
 

 
 

Database: 1.Geodatabase_KNMI_Kaart\Events 

Source:  Direct plotted events from Nederquake 

Type:  Vector points 

 

Definition: Both induced and tectonic earthquakes from the table Nederquake  

  plotted into the RD Grid (X&Y) 

Purpose: To give a clear overview of all the earthquakes in history in the Netherlands 

and surroundings. One can choose between the induced and tectonic 

quakes and there is also the possibility to show the ‘heavy’ quakes of 

Magnitude >2,0 only. 

 
Considerations/Detailed information: 

The earthquakes have been divided in different layers: 

All earthquakes 
 Induced earthquakes  

These earthquakes can be found in the table by ‘TYPE: GH’  and are 

induced by extraction of gas and therefore mainly occur in Groningen.  

 
 Tectonic earthquakes 

Can be found by ‘TYPE: TH’ and are a result of tectonic movements in the 

southern part of the Netherlands. These are divided into two groups: 

   -Recent earthquakes (occurred after 2000) 

   -Older earthquakes (occurred before the 21st century) 

The symbols used to represent the earthquakes are split in five classes, 

sorted by Magnitude. The classes are: 

   M<1 Small earthquakes, hard to analyse by computer 

   M1-2 Medium earthquakes, hard to feel by human 

   M2-3 Larger earthquakes, felt by human, small damages possible 

   M3-4 Large earthquakes, larger damages 

   M>4 By Dutch standards really large, happens rarely. 

So the larger the Magnitude, the larger the symbol in the map. The large 

Magnitudes get exaggerated large symbols, because they do not occur 

often. 

Earthquakes with M>2,0 

Earthquakes with a magnitude smaller than 2,0 can hardly be felt by human. 

(FALW VU, 2013) Only less than 25% of the induced earthquakes are larger 

than this 2,0. All other quakes can cause damage but are not large. To make 

the map not looking too catastrophic, it was chosen to make it possible to only 

show the heavier earthquakes. This is done by using the query:  
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"MAGNITUDE" >= 2.0 AND ("TYPE" = 'GH') 

The same is done to the tectonic earthquakes: 

"MAGNITUDE" >= 2.0 AND ("TYPE" = ‘TH’) 

It was decided to order the symbols in size, so that the large symbols 

would not overlap the small. 

 

Colours:  red/light red and green 

 

See appendix 3 for the result of this layer. 
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Layer: Stations 
 

 
 

Database: 1.Geodatabase_KNMI_Kaart\Stations 

Definition: Reproduction of both ‘dieptemeters’ and ‘oppervlaktemeters’ of the table 

StatNed on RD projection. 

Purpose: To see the spatial distribution of measurement stations. These stations can  

found throughout the whole country varying from accelerometers, 

boreholes and meters at the surface. In this way it can be seen which 

meter can be found where. For example, a lot of borehole meters can be 

found in Groningen because at that place a lot of shallow, small quakes 

occur, which have to be registered.  

 

Source:  Table Statned in Access file Nederquake 

Type:  Vector points, classified by ‘S-Type’  

 
Considerations/Detailed information: 

Two layers have been made, namely one for the current stations, which are still 

being used (+/- 80), and one for the total amount of stations which have ever 

existed (+/- 180). Besides this, different stations have been distinguished. 

 Total stations:  
Because there are different seismometers used to analyse movements of 

the earth, these have to be plotted differently in the map. This difference is 

given in the table Nederquake at the column: S_Type. Symbols categorized 

by value field: ‘S_TYPE’. Some stations did get a different name in the 

table, but are the same type of meter, so has to be given the same symbol 

in the map (e.g.: (V)BB and BB). See figure below for given symbols. 

 Current stations:  
By using the query: 

[IN_OPERATION] = ‘Y’ 

Symbols are given in the same way as in layer ‘Current stations’ 

 

Colours: Grey to Black 

Fixed/ Changeable: Fixed 
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Layer: Gas fields 
 

 
 

Database: 1.Geodatabase_KNMI_Kaart\Gasnew 

Definition: All known gas fields that can be used to extract gas by the   

  Netherlands.  

Purpose: To make clear that most induced earthquakes occur nearby the gas fields. 

There is a certain relationship between this gas extraction and the quakes 

that occur. This is easy to see in this map. 

 

Source:  NLOG Gas Fields 

Type:  Vector, Polygon features 

 
Considerations/Detailed information: 

The gas fields added in the following way: 

1. Download from NLOG (NLOG, 2013) 

2. Open the file in Google Earth 

3. Right click the file on the left side of the screen > Save place as.. > KMZ 

4. In ArcGIS, go to ArcToolbox > Conversion tools > From KML > From KML 

to Layer. 

5. Change browse bar in ‘Input KML File’ into KMZ files, choose saved KMZ file 

and convert. 

 

The transparency of the fields was set at 30% 

 

Colours:  RGB: 255.255.115 

It was decided to put this layer onto the map, but as a part of trying to 

make it not too prominent, transparency was set at 70% and it was given 

the colour yellow.  

 

 

Fixed/ Changeable: Fixed 

 

See appendix 3 for the result of this layer. 
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Layer: Faults 
 

 
 

Database: 1. Geodatabase_KNMI_Kaart\Breuken 

Definition: All important faults of the Netherlands that have something to do with the 

occurring earthquakes.  

Purpose:  Show the relationship between faults (‘horsten’ and ‘slenken’) and 

earthquakes in the southern parts of the Netherlands. 

 

Source:  Gisdata\Seismo 

Type:  Vector polylines 

 
Considerations/Detailed information: 

It was presumed that almost all faults are non-active at the moment. However, 

the Feldbiss and Peelrandbreuk, which are well-known faults for Dutch citizens, 

are given as active. These faults still make the earth move sometimes. 

 

Colours: Polylines in grey and dark grey to point out the difference between the 

active and non-active faults.  

 

See appendix 3 for the result of this layer. 
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Relate layers with table Nederquake  
 

When the map was set up using ArcGIS, it was needed to be related with table 

Nederquake to make it usable for the Seismologic department of the KNMI. For example, 

when a new earthquake occurs it should be plotted into the table directly, and be visible 

in the map.  

By making a connection between the map and the Microsoft Access file Nederquake, the 

map will stay up to date. This is done to the layers Events and Stations, in the following 

way: 

1. In the ArcCatalog, expand ‘Database Connections’ and double-click ‘Add OLE DB 

Connection. 

2. Double-click ‘Microsoft JET 4.0 OLE DB Provider’ 

3. In tab ‘verbinding’/’connection’ select the Microsoft Access file Nederquake 

4. Click ‘Test connection’ and click OK. The map is now connected to the table. 

5. Expand the new OLE DB Connection and drag the tables into the template 

6. Right click the table and choose: Display X and Y. NB: Do not convert this layer 

into a shapefile: in that case, the connection will be lost immediately. 

7. A new layer has been formed now, while connected with the original Nederquake 

table. 

As a result of this relation, each time when opening the template, the connection is 

refreshed automatically and every change in the Access file will be modified in the 

template.  

The formed connection was called: OLE DB Connection_Overview.odc.  

Convert into a map with a  legend  
 

The conversion described below can be viewed in a short version in the quick reference 

guide in appendix 12. 

 

Because the program ArcGIS is limited in making the legend clear and is not really about 

visualising the final maps into detail including the legends, it was decided to only make a 

small legend in ArcGIS. In the next chapter it will be explained how the template still can 

be converted in a high definition poster. 

 

A legend was created using the ‘insert legend’ tool in ArcGIS. Exactly the same layers as 

in the old map were inserted in this legend, to make it look the same. 

 

Two templates were created:  

1. Output\Mapgeodatabase, in which the actual map is stored. In this template, one can 

choose what to see on the poster, for example data frame location and scale.  

1. Output\Legenda, in which the Legenda is being designed. 

 

When a map has to be printed or uploaded on the internet as a high resolution image, 

the right way to do this is: 

 

1. Open Template Mapgeodatabase 

2. Change view to: ‘Layout-view’  

3. Decide what scale you want to have and what should be visible on the map.  

4. Insert>Picture: Volledig.jpg 

 When your reference scale is not 1:1.000.000, choose Picture: Volledig-

 Scalebar 

5. Double-click on the picture and choose ‘size and positioning’ 

6. Change size width to: 20,89 cm. (Height will change automatically) 
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7. Drag the picture in the right position and right-click>order>Send to back 

8. Insert a new scale bar, when reference scale is not 1:1.000.000 

9. Export the new map (DPI: 400-500) 

Eventually, the legend itself can be changed in the Template: Legend 

 
See also Appendix 7 

 

Keeping the map up to date in the future  
 

In the future, the map will have to be revised again. This short chapter has been made to 

make this procedure easier and faster. Some considerations: 

 

 Some shape files (e.g. elevation and borders) will not have to be changed 

in the future. However, some files need to be revised each few years, for 

example to make a new poster. These shape files are listed below and it is 

explained how they should be changed to keep them up to date. 

 

Earthquakes 

As explained before, each time a new earthquakes occurs, this is 

automatically plotted in the table and the template. However, when a new 

poster will be made in a few years, one should think about this: 

o Maybe the earthquakes later than 2000 are not ‘recent’ enough, so 

a new  classification is needed. One could decide to make all 

earthquakes light red, except the ones later than 2005.  

o Maybe in a few years there will be too much earthquakes to keep 

the map clear. Then, it could be decided to only plot the last X 

earthquakes, or make a selection of earthquakes which had a 

Magnitude larger than 2.5. 

 

Stations 

This shape file could have to be changed in the future. In this case, one 

should think about this: 

o Do all stations still exist? Do they all have to be plotted?  

o Next year about 60 new stations might be installed in the northern 

parts of the Netherlands. This will make the map less clear than before. 

Maybe it will be an appropriate solution to make the symbols a bit 

smaller. 

 

 Each time making a new poster: 

The map which can be created using the steps described on the previous page, 

is good enough to be published on the internet. However, when the map has 

to be converted into a poster, a better legend is needed. 

 

Doing this, the procedure is thus: 

1. Exporting the new map with the legend into PDF (Or: the exported map and the 

exported legend) 

2. Send this PDF to the studio, where the new poster can be made. In this way, 

exactly the same poster can be created. Also, the complicated elevation scale bar 

can be converted by a designer using for example Adobe CS. 

 
Example: Appendix 9 
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Part two: Modifying the analysis map 
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 Purpose of the map 
 

The goal of this map is to show where the last earthquake took place. This should be 

done in a simple way, and that is why visualization is not of real interest in this case. 

When a new quake is analysed by one of the KNMI analysts, it is plotted into this map 

directly.  After that, the head of the department has to accept the analysis as right. At 

that moment, he must be able to see where the quake occurred and how large it was, in 

a short period of time. At this point, the map is not clear visualized by a legend, but 

because of the knowledge of its user, it is still clear enough. The ‘analysis map’ is a map 

which is not used to explain the occurrence of earthquakes, or to show all of them as it is 

done on the large map or poster in the previous chapters.  

 Design a new map from template 
 

Compared to the overview map, this map is less complicated. The elevation is not given, 

because this could make the map unclear and does not meet its purpose. The analysis 

map is designed in a different template. This is because almost all layers are different 

than the Earthquake map. The layers are given below and explained when needed. Some 

general comments on the choices which have been made: 

 

 The gas fields are chosen to be layered under the country and sea map. This is 

to make it more clear that these are gas fields, and no clouds. In the original 

map the fields are shown with a high transparency, which immediately gives 

the impression to be a higher layer, up in the air. Now, the fields are shown 

below the sea and country level and by making the transparency of that layers 

higher, it looks like the gas fields are below ground level, which comes closer 

to reality. 

 

 Not all rivers are given, to keep the map as clear as possible. Visualising the 

rivers is not useful when one needs to know how and where the quake took 

place.  

 

 The names of the towns can be given. This layer can be checked or not and by 

zooming respectively in and out, more or less names will be given.  

 

For more detail explanation, see below. The different layers are given in 

figure 1. 

 

 

 

 

 

 

 

 

Figure 1: Overview of the layers in the analysis map template. 
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Layer: Borders 
 

Database: Seisan\Output2\Data\Borders 

Definition: All vector layers which increase clarity concerning the borders on the map, 

e.g. country borders or cities.   

Purpose: As background of the map 

Source:  Most: KNMI\The Netherlands, and: NLOG_Fields 

Type:  Vector points or lines 

 
Considerations/Detailed information: 

The NLOG fields are added in the way as described in appendix 6. As 

mentioned before, the gas fields are placed as bottom layer. By making the 

other layers transparent, the fields seem to be below ground level. 

Colours:  The Netherlands are chosen to be coloured as dark green, as it was done in 

the original map. The other countries are light green coloured, because 

these layers are of no importance for the map. It was chosen to give all 

gas fields the same colour. However in the attribute table, seven different 

fields are given and can be checked when needed. 

 
 
 

 
 

 
 
 

 
 

 

Layer: Built areas 
 

Database: Seisan\Output 2\HGN and \Plaatsnamen 

Definition: All cities and towns in the Netherlands 

Purpose: To make it possible to see where the earthquake took place. Sometimes it 

is good to know which towns or cities are close by the hypocentre. On the 

original map, only large towns were given. Now it is decided to show all 

built objects, including the small villages. This might be important, when an 

earthquake took place below one of these villages. 

Source:  Small villages: HGG (Historisch Grondgebruik) 

  Towns: CBS Bevolkingskernen (CBS, 2013) 

Type:  Vector (CBS) and Raster (HGG), Cell size 25x25m 

 
Considerations/Detailed information: 

Layers are clipped on the Netherlands. There has been added one option to select: 

turn on the labels of the names of the cities and towns. See explanation in 

chapter: ‘convert into a map’ 

Colours:   All areas are given the colours orange (RGB: 230, 152, 0). In Top250, all 

other values are set as ‘no colour’. 
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Layer: Water 
 

Database: Seisan\Output2\Data\EU_Sea or \NL_River 

Definition: Water polygons which are needed to show the sea and (some) rivers.  

Purpose: To see if there is a river close by the earth quake location.   

Source:  Datasets\KNMI\the Netherlands\ 

Type:  Vector 

 
Considerations/Detailed information: 

Not all rivers are shown, to keep the map ‘clean’ and easy to read. Transparency 

of sea is set at 30% to make gas fields visible.  

Colours: Both rivers and sea are shown as light blue (RGB: 163, 232, 255) 

 

 

 

 

 
 

 
 
 

 
 

 
 
 

 
 

 

Layer: Cross 
 

Database: Seisan\Output 2\Data\Events (Related to table Nederquake) 

Definition: A large cross on the location of the last earthquake    

Purpose: To see where the most recent earthquake took place. Because the density 

of quakes is high at some locations, this cross is needed to be able to see 

where exactly the hypocentre is.  

Source:  Nederquake 

Type:  Vector point 

 
Considerations/Detailed information: 

This layer originally contained all earthquakes, but using the query definition tab 

(Related: LQ) only the last quake is shown. Because this layer is also related to 

the table Nederquake, this cross will change of location each time that a new 

quake occurred. 

Colours:  Purple (RGB: 168, 0, 132), size 80,00 
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Layer: Events  
Database: Output 2\Data\Events (Related to table Nederquake) 

Definition: All analysed earthquakes in history, which are described in table 

Nederquake, divided in induced and tectonic quakes. 

Purpose: To show the location of all earthquakes in history, analysed by KNMI. 

Source:  Nederquake 

Type:  Vector points, displayed on map by X and Y points (RD projection) 

 
Considerations/Detailed information: 

 Because of the high amount of quakes which are on the map, a lot of them are 

not really visible. To reduce this problem in the large map, the small quakes were 

layered above the larger quakes. However, in this map this is not a good solution, 

because a lot of quakes will still be not visible. It was decided to plot the quakes 

in two layers. A layer with transparent rings are layered on top of a layer with 

symbols that are filled. In this way, all events can be seen on the map.  

 Like in the other map, induced and tectonic events are distinguished.  

 To make the map not chaotic, it was decided to give the small events (<2,0M) a 

very small symbol. From 2,0 up to the largest event the symbols have a larger 

size.  

 

Colours:  Tectonic quakes are coloured red and induced quakes are green.  

Fixed:  Changeable. 

 

 

 

 
 

 
 
 

 
 
 

Layer: StatNed 
Database: 2.Output\Data\Stations 

Definition: Used stations to record earthquakes in the Netherlands.  

Purpose: To make clear where the stations are situated and which types are  

  being used. 

Source:  Nederquake StatNed 

Type:  Vector points, projected into RD_X and RD_Y, connected to table 

 
Considerations / Detailed information: 

Distinguishing the stations which are still being used and the ones that used to be 

active is done by using the Definition Query tab in the layer properties. In the 

field: GESLOTEN, the still existing stations have been given the number ‘0’.  

The query for active stations: ‘GESLOTEN’=>’0’ 

The query for non-active stations: ‘GESLOTEN’=’0’ 

Stations which are not being used for analyses are given 40% transparency 

For distinguishing the different seismometers, see layer Stations in Overview Map. 

Colours:   Colours have been chosen to be black, grey and light grey 

Fixed:   Fixed, but data is constantly updated by table StatNed. 
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A new option: Showing ‘LQ Stations’ 

When a new quake is plotted in the analysis map, this is visualized by putting a cross at 

that location. It is explained that this makes the analysis easier. In this new map, an 

option has been designed to also display the stations which analysed the last quake (LQ). 

In some other analysis programs this is done too, because this is an adequate tool to see 

by which stations the quake was felt. A new layer was created to make this possible: 

Layer:  LQ Stations 
 

Database: Related to query ‘LQ_Stations’ 

Definition: All stations which were used to analyse the LQ 

Purpose: To make clear at which locations the quake could be felt, and to see  

  which seismometers were used to analyse the quake. 

Source:  Table Nederquake, Readings and Statned. 

Type:  Vector points 

 
Considerations/Detailed information: 

A new query was made in Microsoft Access table Nederquake, using the tables 

Nederquake, Readings and StatNed. These tables were related by ID and Station 

Name (appendix 8). In this way, each reading is given, including the name and 

location of the station which registered the quake. On the Related tab of this 

query, the criteria used was: =”LQ”.  When this query is dragged into the 

template in ArcGIS, all stations which were used to analyse the LQ are given. The 

symbology of these stations is the same as in the layer “StatNed”. Besides this, a 

small cross is placed at the location of LQ. This is done to mark the epicentre of 

the quake, because this is sometimes unclear when the LQ found place in for 

example Groningen, where a lot of other quakes are layered. See appendix 8 for 

explaining figures. 

 

Colours:  The same as in layer “StatNed”; grey, circles 

Fixed/Changeable:  Constantly changing. 
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Relate with table Nederquake 
By making a connection between the map and the Microsoft Access file Nederquake, the 

map will stay up to date. This is done to the layers: Events, Stations and the cross in the 

following way: 

1. In the ArcCatalog, expand ‘Database Connections’ and double-click ‘Add OLE DB 

Connection. 

2. Double-click ‘Microsoft JET 4.0 OLE DB Provider’ 

3. In tab ‘verbinding’/’connection’ select the Microsoft Access file Nederquake 

4. Click ‘Test connection’ and click OK. The map is now connected to the table. 

5. Expand the new OLE DB Connection and drag the tables into the template 

6. Right click the table and choose: Display X and Y. NB: Do not convert this layer 

into a shapefile. In that case the connection with the Access file will be lost 

immediately. 

7. A new layer has been formed now, while connected with the original Nederquake 

table. 

 

For this map, the Connection was called: OLE DB Connection_Analysis.odc 

As a result of this relation, each time when opening the template, the connection is 

refreshed automatically and every change in the Access file will be modified in the 

template.  

 

Convert into a map  
 

The map can be easily converted into a map which can be exported or printed. In the 

lay-out view, the scale reference bar is automatically inserted, and put into the left upper 

corner. In the right upper corner, a text is inserted. In this text, the Quake Number 

(QNR) can be written. Besides this, the logo of KNMI is visible on the upper-midst of the 

page. In this way, the map looks exactly the same as the old one. A legend is not needed 

for this map because the user knows what is visualised on the map, as explained before. 

 

In this map, it is possible to change the reference scale. This has to be done in the layout 

view and not in the data view to keep the exported map scaled as inserted. 

Because it will be necessary sometimes to zoom in on the map, this is possible now. 

Certainly in the Groningen province this needs to be done, because there are too many 

quakes to make a clear visualization on the map.  

 

In this map the names of the towns and villages can be given. This can be done by 

clicking on Borders > Bebouwing > Namen tonen. This layer consists of three datasets of 

cities and towns. By zooming in or out, more or less names will be given. In this way, 

also the names of very small hamlets can be seen, when the map is zoomed in, which is 

sometimes necessary to know in which area the quake took place. How this was done 

can be found below: 
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Three datasets: 

 Naam_Stad; only large cities, as shown in the normal exported map with 

scale  1:400.000 

 Naam_Dorp; also smaller villages like Winschoten 

 Naam_Kernen; each city, town, village and hamlet 

Each dataset is set to 100% transparency to make the vector points invisible. By clicking 

the window ‘Customize’>Toolbars>Labelling, it is possible to make the labels visible or 

invisible at a certain scale range. This has been done in this way: 

 

 
 

Now, the different labels will be visible by zooming in or out.  

 

 
Stations name 

Also, the names of the stations can be given. This can be done by clicking on the dataset 

‘stations’>Namen tonen. This was done by making the stations transparent and turning 

on the labels. The labels are automatically turned on when the scale is smaller than 

1:150.000, which was done by using the labelling toolbar: 

 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 

 
To show the results of using these tools, some maps were added in appendix 10. First, a 

map with scale 1:400.000 is given, which is the normal scale of the analysis map. 

Secondly, two extra maps are given, visualizing the changes when the map is zoomed in, 

which could be used when a quake occurred in the neighbourhood of the city Groningen. 
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Setting up a File Geodatabase 
 

All data of the created layers in this internship were stored in folders . However, to make 

it easier to transport all data from computer to computer, all files were stored in a File 

Geodatabase. In that way, all data can be found in one map, and this is much more 

clearer in ArcCatalog: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A file geodatabase can be created by right clicking ‘New> File Geodatabase’ in the 

ArcCatalog. To make the geodatabase clear, it is advised to create different feature 

datasets. In this feature dataset a vector dataset can be imported by right clicking 

‘Import > Feature class (simple).   

In case of inserting a raster dataset: New > Raster dataset. 

Some layers are not stored in the geodatabase, because they are directly connected to 

the table Nederquake.  
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Conclusions 
 

The maps and templates have been revised in ArcGIS 10.0, as was the goal for this 

internship. Some conclusions can be drawn to make clear what has been done to 

accomplish this: 

 

 Converting the template ‘Overview map’ into a poster has been done as good 

as possible. Because this internship was not really about maximizing 

visualisation it was concluded to make it as good as possible in ArcGIS, but 

outsourcing the final layout to the a design studio, which will be able to 

convert it into an appropriate poster. 

 

 All data which needs to be up to date in the future, is related to Microsoft 

Access’ tables and queries. In this way, the templates are being changed 

automatically when a new quake is plotted or when a new station has been 

added to the table Statned. For showing the stations which were used to 

analyse the last quake (LQ) a new query was formed.  

 

 Some new options were created: 

 Overview Map: 

  Fixed legend map; easy converting into a poster 

  Easy changing between tectonic recent and old quakes 

  Possibility to choose between all stations and current stations 

  Well-structured layers in ArcGIS 

 Analysis Map:  

  More cities shown 

  Show labelling of cities and villages 

  Last quake stations  

 

 A few layers have been changed in colours to make them more clear  

 

 (e.g. the colour of the rivers) 

 

 A few layers have been added or grouped to make them well-structured and 

efficient 

 

 A few layers have been deleted because they were not needed 

 

 All data has been stored in the File Geodatabase, as described on page 29. 

This makes the database structured in one place and easy to see or change 

 

 The planning as a whole went well. The original planning made in the first 

week of the internship, has not been changed very much. The time that was 

planned as a has been used to finalize the templates and this report. 

 

Finally, the internship has resulted in a well-structured and efficient way of storing data 

for the templates for ArcGIS. The difference on structure between before and after the 

internship can be seen in Appendix 11. 

 

Hereafter, all appendices with both explanations on the analyses and the real manual as 

quick reference guide can be found in the appendices. 
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ArcToolbox 10.0 

Provides a toolbox which contains all tools and analyses that can be used in the program 

ArcGIS Desktop. This Toolbox has been used much to make the templates for this 

internship. 

Outlook 
 

During the internship, I have been really into the details of the database and some things 

seemed to be very inefficient and not logical to me. Because it was not part of my 

assignment or there was no time I was not able to tackle those problems. I listed these 

things below as an advice, so it still could be used in the future: 

 

 The whole of the Access file Nederquake should to be rebuild. Nederquake has 

been set up during a period of 30 years, and now some tables are not relevant or 

double. Making the Access table clear, 75 percent of the amount of tables could 

be thrown away. Actually, revising all of the tables will take quite a lot of time. 

 In table ‘Nederquake’, one quake (QNR=10) is given the type: gH instead of GH. 

This small difference has to be changed. 

 For the elevation on the Overview map, the AHN of 25 meter could be used 

instead of the 100x100 meter pixels which is used now. The computer used during 

this internship did not have enough space to run the 25  meter layer in the 

program ArcGIS very well.  

 A possible addition to the analysis map could be all datasets containing the faults 

in the Netherlands and surroundings. It could be useful to be able to see where 

the faults are situated when analysis is done. 
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Appendices 
 

 

 

Appendix 1 Overview of the layer structure ‘Overview Map’ 

 

Appendix 2 Overview of layer content of map Templates in ArcGIS 

 

Appendix 3 Overview of mapped layers of ‘Overview Map’ 

 

Appendix 4 How to.. Convert different raster files into one mosaic. 

 

Appendix 5 Overview map: Scaling the elevation 

 

Appendix 6 How to.. Add a KML/KMZ file in ArcGIS 

  

Appendix 7 How to.. Make Access Query LQ_Stations 

 

Appendix 8 Result: Overview of the final map 

 

Appendix 9 Result: Overview of the final map 

 

Appendix 10 Result: The structure in ArcGIS template ‘Analysis Map’ before  

    and after the internship 

 

Appendix 11 Quick Reference Quide 1 

 Convert the overview map template into a poster 

 

Appendix 12 Quick Reference Quide 2 

 Convert the analysis map template  into a map  
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Appendix 1 
Overview of layer structure in template Overview Map 
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Appendix 2 
Overview of layers content in ArcGIS 
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Appendix 3  
Overview of results of different layers, as layered in ArcGIS template Overview map. 
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Appendix 4 
How to.. 

 Convert different raster files into one mosaic.  

 

1. Download NASA Aster files, store them and extract. 

(Stored: 1.Geodatabase_KNMI_Kaart\Elevation\Aster) 

 

2. Resample all files (10-4 into 5,0E-4) 

(Toolbox/Data Management Tools/Raster/Raster Processing/Resample) 

(Stored: KNMI/Kaart/Basismap/Resampled) 

 

3. Creating a new Catalog in ArcMap  
(Right-click  New  File Geodatabase and New  Catalog Raster) 

 

Raster Catalog Name:  DataElevationModel_CATALOG50 

Coordinate System:   RD_New 

Raster Management type: Unmanaged 

‘OK’ 

 

4. Load files into Catalog 
(Right-Click  Load  From Database) 

 

5. N.B.: Load full map  (/resamples) (one mouse click on map ‘resamples’ and ‘add’) 

 

6. Drag Catalog into ‘Template’; all maps are visible now 

 

7. Convert into Raster dataset 

(Toolbox/Data Management Tools/Raster/Raster Dataset/Raster Catalog to Raster 

Dataset) 

 

Appendix 5 
Scaling the elevation.  

 

Exaggeration of elevation differences in lower areas, as can be seen: 24 intervals, of 

which 10 between a elevation range of -4 to 20 meters, so 42% of intervals for 3% of 

elevation heights. Properties > Symbolisation > Advanced Labelling. 
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Appendix 6 
How to… 

 Add a KML file in ArcGIS 

 

The gas fields added in the following way: 

1. Download from NLOG (NLOG, 2013) 

2. Open the file in Google Earth by double clicking on it 

3. Right click the file on the left side of the screen > Save place as.. > KMZ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. In ArcGIS, go to ArcToolbox > Conversion tools > From KML > From KML to 

Layer. 

 

 

 

 

 

 

 

 

5. Change browse bar in ‘Input KML File’ into KMZ files, choose saved KMZ file and 

convert. 
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Appendix 7 
How to.. 

 Make query: LQ_Stations. 

 

Explanation on query LQ_Stations, as part of the new optional layer in Analysis Map 

 

1. Make a new query in Access 

2. Select the three tables: Nederquake, Readings and StatNed. 

3. Drag the tables into the query and combine them as in the figure below: 

 

 

 

 

 

 

 

 

 

 

 

4. Make a query with six columns, gathering its information from the three tables, as 

done below: 

 

5. By saving the design view and changing to query view, the next query will become 

visible: 

 

6. Now each reading is given with the X and Y coordinates of the station and the X 

and Y coordinate of the reading. Because of the criteria ‘LQ’,  the query only 

shows the readings of LQ. By connecting this query to ArcGIS, all stations will 

become visible which analysed the last quake. 
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Appendix 8 
Overview of the final legend and overview map (next page) 
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Appendix 9 
Overview of the final analysis maps. 1:400.000, 1:200.000 and 1:100.000.
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Appendix 10 
  

The structure in ArcGIS template ‘Analysis Map’ before and after the internship: 
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Appendix 11 
Quick Reference Guide 1 

 

Converting the Overview Map into a map or poster 

 

1. Open ArcGIS Template Mapgeodatabase 

 

2. Change view to ‘layout-view’  

 

3. Decide what scale and data frame view has to be visible on the map, with: 

 

4. Insert>Picture: Volledig.jpg 

 Note: When your reference scale is not 1:1.000.000, choose Picture: Volledig-

 Scalebar. 

 

5. Double-click on the picture and choose ‘size and positioning’. Use:  

 

6. Change size width to: 20,89 cm. (Height changes automatically) 

 

7. Drag the picture in the right position and right-click > ‘order’ > ‘Send to back’ 

 

8. Insert a new scale bar, when reference scale is not 1:1.000.000 

 

9. Take considerations and look at options as written below: 

 
  Considerations 

 

 Which stations have to be shown on the map?  

 Choose between ‘all stations’ or ‘current stations’ 

 

 Show RD Grid (Double click ‘Layers’ > ‘Grids’ > check ‘Measured Grid’ > ‘Apply’) 

  
  Possible other options 

 

 When legend needs to be changed, this can be done in template ‘Legend’.  

 

 Change the limit value between ‘recent’ and ‘old’ quakes. This is now set at 2000, 

but might be changed in the future, to make 

visualisation better.  

 This can be done by: 

 Double click on layer ‘Events_Tect_Recent’  

 > Tab: ‘Definition Query’  

 > Change ‘20000000’ in e.g.  ‘20050000’ 

 -Do the same for layer ‘Events_Tect_Before’ 

 

 

 

10. Export the new map and send to KNMI Studio to make a new poster 

 File > Export map 
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Appendix 12 
Quick Reference Guide 2 

 

Converting the Analysis Map template into a map 

 

 

1. Open ArcGIS template AnalyseKaart 

 

2. Change view to ‘layout-view’ 

 

3. Switch to the right view by dragging the map with: 

 

 Note that the Last Quake Cross should be visible on the map 

 

4. Eventually, change the map’s scale reference bar 

 

5. Change title of QNR at the right upper corner by double-clicking on it. Use:  

 

6. See considerations and other options below to finalize the visualization 

 
  Considerations 

 

 Which scale reference will be the best for this map? 

 Think of: - Amount of quakes visible; not too crowded? 

   - City names visible; names of hamlets also expected to be visible? 

 E.g. when a new quake occurs in the neighbourhood of Groningen, scale 

 1:200.000 would be the best option. However, when five quakes occur at the 

 same place in one week, it would be useful to zoom in to make the small  

 villages visible. 

 

 Show all stations or only the stations that were used to 

analyse LQ?  

 
  Possible other options: 

 

 Show RD Grid (Double click ‘Layers’ > ‘Grids’ > check ‘Measured Grid’ > ‘Apply’) 

 

 Map with quakes becoming too crowded? Choose ‘Layered’ instead of 

‘Ringed’   

 Show only the quakes of 2013 

 

 

 

 Eventually, label the names of the LQ stations. This is automatically done when 

scale reference is 1:150.000 or smaller, but might be useful to do it also at 

another scale. 

 

7. Export map or print map  (File > Print or File > Export map) 

  



 



A complete list of all KNMI-publications (1854 – 
present) can be found on our website  
 
www.knmi.nl/knmi-library/knmipub_en.html 
 
 
 
 

 
 
 
 
 

The most recent reports are available as a PDF on 
this site. 
 
 



 


